Setting Type 3374 Electric Actuator
equipped with digital positioner
using TROVIS-VIEW Operator Interface

Fig. 1 ⋅ TROVIS-VIEW Operator Interface for Type 3374 Electric Actuator

Operating instructions
EB 8331-2 EN
®
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Modifications of positioner firmware in comparison to previous version
Former 1.1

New 1.2
In operating modes 1 and 2, travel calibration is also possible
for the closed position of the valve even when the actuator stem
retracts.
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1. General information
A CD-ROM containing the program for installing the TROVIS-VIEW Configuration and
Operator Interface is provided by SAMSON.
To start the installation program, insert the installation CD-ROM. Once inserted, the CDROM usually starts the installation program automatically - depending on the configuration
of the operating system. If the program is not started automatically, double-click setup.exe in
the root directory of the CD-ROM in order to install TROVIS-VIEW. Then, observe the instructions that come with the installation program.
The system requirements are specified in the readme.txt file in the root directory of the CD-ROM.
As different SAMSON devices can be operated using the TROVIS-VIEW Operator Interface,
the installation program prompts you to select the device modules acquired by you. Note
that the installation program also offers you the possibility of installing a demo version of the
software. On installing the respective device modules, you need to enter the corresponding
identification codes indicated on the CD-ROM case.
To enable communication with the PC, connect the serial interface COM1 or COM2 to the
serial interface (RJ-12 jack) located on the positioner board of the actuator using a
SAMSON connecting cable.
You can set the positioner using the TROVIS-VIEW Operator Interface installed on your PC
and then transfer this setting directly to the positioner at the place of installation of the control valve using a SAMSON connecting cable. During the transfer, the positioner checks if
the data set by you is reliable and complete.
You can calibrate the travel of a control valve using the TROVIS-VIEW Operator Interface.
Alternatively, you can make the TROVIS-VIEW Operator Interface read and display the current setting of your positioner.
Note: A hardware package (Order No. 1400-7704) is available that includes a memory
pen, a connecting cable and a modular adapter. The memory pen is also available separately,
see chapter 5.
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2. Setting
2.1 Start-up
Note: Before you set the positioner using the TROVIS-VIEW Operator Interface, you must
first mount the actuator onto the control valve as described in section 2.2 and establish
the electrical connections as described in section 3 of the mounting and operating
instructions EB 8331-1 EN.
1. Set the selector switch (2) to operating mode 0 =
(control switched off).
2. Check if the rated travel indicated on top of the potentiometer gear (12) corresponds
with the rated travel of the control valve.
The inscription for the rated travel ("Nennhub") is
15 (for 6 to 20 mm travel) on one side or
30 (for 6 to 35 mm travel) on the other side of the potentiometer gear.
If the rated travel indicated on top of the potentiometer gear and hence the mounting position of the gear (see Fig. 2) do not correspond with the rated travel of the control valve, pull
the gear off the shaft and put it back on again with the other side facing upward allowing
the mating gear (14) to engage properly.
Make sure that the shaft of the potentiometer (13) is not altered.
Important: Actuators with fail-safe action "actuator stem retracts or extends" are only
designed for rated travel 15 mm. Do not rearrange the gear.
3. Switch on the auxiliary power.
4. Set the selector switch (2) to operating mode 3.
5. Establish communication between the PC and actuator using the SAMSON connecting
cable.
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1 2
1
2
3
4
5
6
7
8
9
10
11
12
13
14

Operating mode 1
Selector switch
Operating mode 2
Travel calibration button
Operating mode 0
Operating mode 3
Potentiometer clockwise
or counterclockwise
Upper signal lamp
Lower signal lamp
Actuator stem retracts
and extends
Jack (serial interface)
Potentiometer gear
Potentiometer
Mating gear

3

4

5

6

7

8

9

SAMSON

2
10

1

3
11
Stellungsregler
Positioner
Régulateur de position

Potentiometer gear (12)
Mounting position for
rated travel 15

Potentiometer gear (12)
Mounting position for
rated travel 30

en
15 nhu
b

12
N

Inscription for
rated travel
("Nennhub")

12.1

Fig. 2 ⋅ Positioner board and mounting position of potentiometer gear
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2.2 Using TROVIS-VIEW
1. Start TROVIS-VIEW.

2. If you want to change the language, click on the Options (or Optionen) menu, point to
Language (or Sprache) and then select the language you want.
3. On the View menu, deactivate the bars you do not want to be displayed, e.g. the infobar.
4. To select the corresponding serial interface, click the Options menu, choose Communication and then Settings.

5. The expert is allowed to set and modify the positioner data whereas the maintenance
technician (default) is only allowed to read it. To be able to set the data according to the
following instructions, click on the Device menu, choose User Level and then select Expert from the drop-down list. The options
Expert and Factory calibration require a
password to be entered. In order to modify
the default password samson of one option,
click the Modify Password button and specify a new password of up to 8 characters.
Default password: samson

6
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6. Double-click the Operating mode 3 folder in the folder hierarchy.

7. Then double-click the Setting folder to display the current setting.

Setting:
Note that you can only modify parameters featuring the
symbol. Parameters with the
symbol cannot be modified. In order to modify the parameters of the input variable (reference variable), the position feedback signal or additional settings, use the left mouse button
to double-click the corresponding row. This brings up the Modify Parameter dialog box in
which you can change the setting of the respective parameter.
Input variable
The default values of the lower and upper ranges of the reference variable are 4 and 20
mA. If you, for example, want to connect two or more actuators in parallel to achieve split
range service, set the lower range of
the actuator to a value between 0
and 15 mA and the smallest span to
4 mA.

EB 8331-2EN
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Position feedback signal
The position feedback signal is used for remote transmission of the current valve position.
The lower and upper ranges can lie between 0 and 20 mA.
Additional settings
Priority position
If the priority position function is activated in the Setting folder of the Operating mode 3 folder
and an external signal triggers the priority position function at terminals 81 and 82 during the
control operation, the actuator stem moves into the opened position (actuator stem retracts) or
into the closed position of the valve (actuator stem extends) according to the setting of the priority
position selected from the drop-down list of the Modify Parameter dialog box.
Control operation when input variable fails
This function allows you to determine whether the last travel value or the internal reference
value is used for control operation when the input variable fails. These values can be selected from the drop-down list in the corresponding Modify Parameter dialog box. This control
operation is activated when the input variable falls below 0.5 V or 1 mA.
Binary output
This function is used to determine whether the binary output signal serves as a status monitor, as
a monitor for control switched off or as a limit monitor. If you select limit monitor from the dropdown list, you have to determine the parameters of the limit monitor (i.e. the switching behavior,
switching value and differential gap) in the following rows, too.
Exact final position
When this function is activated, the plug stem moves into its exact final position in the closing
phase because the differential gap resulting from the three-step behavior of the positioner is
reduced by means of optimization.
Maximum dead band width
Can be set to values ranging between 1.1 and 5.0 %.
Travel (if SAMSON memory pen is used)
In case the travel range of the control valve is transferred by the SAMSON memory pen, you
can set the travel to any value between 6.0 and 35.0 mm.
Control valve closes when (if SAMSON memory pen is used)
This function is used to determine whether the control valve closes when the actuator stem
"extends" or "retracts".
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7. Double-click the Characteristic folder of the Operating mode 3 folder. Then double-click
the Characteristic row in the list to bring up the Characteristic dialog box which displays
the default setting of a linear characteristic defined by two points and called <Custom>.
In order to define a new characteristic on the basis of the default characteristic, click the
Point button and then select Add from the pop-up menu to add one point.
In order to save this characteristic, click the Characteristic button, select Save As from the
pop-up menu and specify a new name.
To open another default characteristic or a characteristic already stored by you, click the
Characteristic button and then select Open to bring up the Open dialog box in the language of your operating system. In this box, click the desired characteristic or doubleclick the 3374 folder and then one of the default characteristics Gleichproz.inv.txt (i.e.
Rev.equalpercentage.txt), Gleichprozentig.txt (i.e. Equalpercentage.txt), Linear fallend.txt (i.e. Linearlydecreasing.txt) or Linear steigend.txt (i.e. Linearlyincreasing.txt).
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8. On the Edit menu, click Customer Data to bring up the Customer Data window. Then,
enter the customer-specific data concerning the actuator.

9. On the Device menu, click Download to Device (or activate the respective symbol on the
devicebar) to download the setting data to the device. Click OK when the following message appears.

Note: You can print the setting data by clicking Print on the File menu.
Important: The operator interface enables you to reset the data modified by you to the
default values at any time. To reset the data, click on the Edit menu and then select Load
Factory Defaults.
symbol to transfer
Uploading: Click Upload from Device on the Device menu or click the
all setting data of the control valve to the operator interface where you can check and
modify them if necessary. Note that you can activate and deactivate the Additionally Read
Factory Setting function by clicking on the Device menu and selecting Additionally Read
Factory Setting.
Downloading: Click Download to Device on the Device menu or the
transfer the modified setting data back to the actuator.
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2.3 Travel calibration
After having transferred all setting data to the actuator, you can calibrate the travel.
CAUTION
The automatic travel calibration lasts approximately twice as long as the actuators
transit time. During this, the valve moves out of its present position. Carry out the
travel calibration on the test bench or when the shut-off valves in the plant are closed.
1. On the Device menu, select Calibration of Control Valve to bring up the Calibration of
Control Valve dialog box.

2. In this box, select either calibration
to Maximum travel range or to Limited travel range and determine whether the control
valve closes when the actuator stem retracts or extends.
3. In order to initialize the travel calibration, click the Start Calibration button.
The progress bar indicates the calibration progress. Pay attention to the messages
displayed in the status field!
If the status field reads Mounting position of potentiometer shaft is incorrect, the
corresponding signal lamp of the positioner board starts to blink indicating that the
potentiometer shaft (13) has been wrongly positioned and must be readjusted manually
(see Fig. 2).
But do not alter the potentiometer until the closed position is actually reached. The closed
position is indicated by the associated limit switch located on the board and activated
by the tag.

EB 8331-2EN
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In order to correct the position of the potentiometer shaft (13), use a screwdriver to
gradually turn the potentiometer shaft clockwise or counterclockwise in accordance with
the symbols (7) until the signal lamp stops blinking and is lit constantly. Turn the screwdriver counterclockwise if the upper signal lamp (8) blinks and turn it clockwise if the
lower signal lamp (9) blinks. The travel calibration will not continue until both signal
lamps are lit at the same time.
If the status field reads Calibration finished, the travel has been calibrated successfully.
The actuator starts its control operation in response to its reference variable.
If the status field reads Mounting position of potentiometer gear is incorrect during the
travel calibration, check if the correct side of the gear is facing upward.
Note: If there is no travel movement during the calibration (which is due to a loose or
missing potentiometer gear, for example), the two signal lamps blink alternately. Then,
the travel calibration is canceled after a short period of time and the error message
Controlled variable does not change! is displayed. Click OK, remedy the error and then
restart the travel calibration.
4. Close the Calibration of Control Valve dialog box and cancel communication by
disconnecting the SAMSON connecting cable.

3. Additional functions
The operator interface allows you to take advantage of the following functions:
Testing with the stored setting data
Monitoring the positioners control behavior in control operation
Displaying the relevant setting data
Reporting defined events in control operation.






3.1 Testing
To start the test run, click Test on the Device menu and then select Start. Note that you can
only carry out the test run in one of the operating modes 1, 2 and 3. In order to select one of
the operating modes, set the selector switch (2) of the positioner to the corresponding
operating mode.
The test run starts to generate an input variable which increases from the determined lower
range (if the input variable corresponds to the lower range value) to the determined upper
range at a constant rate. When it reaches the upper range value, it automatically switches
over and continuously decreases until it reaches the lower range again and stops the test run.
This continuously changing input signal is transferred from the operator interface to the
positioner of the actuator during the test run and causes the control valve to open or close
according to the increasing or decreasing signal. The resulting travel position of the control
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valve, the difference between the input variable and the travel position as well as the current
dead band width are continuously transferred from the positioner to the operator interface
during the test run and their continuously changing values can be monitored on the operator
interface. The changing values of the input variable (reference variable w) and travel position
(controlled variable x) are displayed graphically and numerically whereas the difference
between the input variable and the travel position in percent, the current dead band width
and the operating mode are only displayed numerically.
You can determine the rate of change of the input variable by entering a time parameter in
the Time slot text box. The time parameter determines the transit time from the lower range
to the upper range of the input variable. This parameter should exceed the transit time of the
actuator.

EB 8331-2EN
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3.2 Monitoring
You can monitor the control behavior of the positioner in any operating mode. In order to
select one operating mode, set the selector switch (2) of the positioner to the desired operating mode. In order to monitor the positioner during normal operation, click on the Device
menu and select Monitor to bring up the Monitor dialog box. Then determine the monitoring
time interval in the Time slot text box and select Start.
After the transfer has been initialized, the current input variable, the current travel position of
the control valve, the difference between the input variable and the travel position as well as
the current dead band width are continuously transferred from the positioner to the operator
interface and can be monitored on the operator interface.
The values of the input variable and the travel position are continuously displayed as graphs
on the operator interface for certain periods of time. Moreover, the input variable and the
travel position, their difference in percent, the dead band width and the operating mode are
displayed numerically.
Note that you cannot influence the control behavior of the positioner by just monitoring it.

14
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3.3 Displaying positioner data
In order to display the most important data of the positioner, double-click the Information
folder and then the Display folder in the folder hierarchy. Then click on the Device menu and
select Upload from Device to upload the current setting data and other information from the
positioner and to display them on the operator interface.
The relation between the input variable and the travel position is displayed as a characteristic and the most frequent travel range as a bar graph which is updated whenever the
data is uploaded from the positioner.
Note that the display of the data varies according to the operating mode selected.

EB 8331-2EN
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3.4 Reporting defined events
In order to display the events which have occurred during the control operation of the
positioner, double-click the Information folder and then the Messages folder in the folder
hierarchy. Then click on the Device menu and select Upload from Device to upload the
currently reported events from the positioner and to display them on the operator interface.

The following defined events might be reported:

 Input variable outside of range [ < 0 %; > 105 %]
 Zero shift [has occurred] -> Initialization if travel > 5 % and travel rate = 0 mm/s and


input variable corresponds to the lower range of the reference variable
Positioner [cannot calibrate] -> if error > 2 dead band widths and travel rate = 0 mm/s;
time-delayed message
Operating temperature [outside of operating range] -> if temperature < 1 °C or > 64 °C
Communication [inactive] -> if time-monitored data traffic does not take place



 Operating direction of actuator stem [check] -> display if operating mode 3 is switched
over to 1 or 2 or vice versa and the closed position of the control valve is altered
Priority operation [active] -> if binary entry is switched active
Limit monitor [active] -> if set limit value is not reached or is exceeded.



 Control operation [with last travel value; with internal reference value] -> when input variable fails
4. Factory calibration
The factory calibration comprises the basic setting of the positioner, the travel calibration of
the actuator as well as the entering of the serial number and is carried out at the factory.
If necessary, for example, if you have replaced the electronic components, you can also
carry out the factory calibration at the place of installation of the actuator using a PC, the
TROVIS-VIEW Operator Interface, a current or a voltage source, a sufficiently precise
ammeter or voltmeter and a sufficiently precise, mechanical length measuring instrument.
Note: The factory calibration requires that the actuator be isolated from the control valve. After
factory calibration is completed, you have to recalibrate the travel of the control valve! Moreover,
factory calibration requires that the selector switch (2) be set to operating mode 0 =
.
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In order to start factory calibration, click on the Device menu, choose User Level and then
select Factory calibration from the drop-down list. Enter the required password samson (also
refer to page 6) and click OK. Then double-click the Factory calibration folder.
You can calibrate the input variable and the position feedback signal if necessary. Connect the
corresponding instruments and use the right mouse button to execute the factory calibration.
The calibration of the actuator requires that you first determine the maximum operating
range by measuring the final positions of the actuator stem. To determine the final positions,
double-click the Extend actuator stem row and select Yes from the drop-down list. Then rightclick the same row and select Write from the pop-up menu to cause the actuator stem to extend.
Then measure the final position. Right-click the Extend actuator stem row and select Default:
No from the pop-up menu. Then right-click the same row again and select Write to execute
this command. Double-click the Retract actuator stem row and proceed as described above.
Then calculate the difference of the two measured values to obtain the maximum operating range.
In order to calibrate the actuator, double-click the Activate actuator calibration row. This
brings up the Calibration of Actuator dialog box. Determine the mains frequency, the rated
travel, the nominal actuating time (for indication, refer to nameplate) and enter the calculated value of the maximum operating range in the Maximum operating range of actuator text
field. Then start calibration by clicking the Start Calibration button. For further details, refer
to section 2.3, step 3 on page 11.
Note: If the factory calibration has not been carried out completely, the signal lamp (9) starts
to blink. The message that the calibration or the serial number is missing is displayed in the
Calibration has not been carried out completely section of the Messages folder located in the
Information folder.

EB 8331-2EN
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5. SAMSON memory pen
The SAMSON memory pen (Order No.1400-7697) is able to load and store data in its nonvolatile memory and serves as a data carrier because it can be used to transfer the setting
data of the positioner from the TROVIS-VIEW Operator Interface to the actuator and vice versa.
From the Memory Pen menu of the TROVIS-VIEW Operator Interface, you can select the
most relevant functions such as Upload from Memory Pen, Download to Memory Pen and
Modify Memory Pen Status and then modify the settings.

Note that you need a SAMSON modular adapter (Order No.1400-7698) to transfer the
setting data from the PC to the memory pen and vice versa. In order to transfer the setting
data from the memory pen to the positioner and vice versa, you do not require any adapter
because the connector of the memory pen fits the jack of the positioner board. The SAMSON
memory pen makes it easy to exchange data with the positioner.
The memory pen enables you, for example, to copy the setting data of one positioner to the
positioner of another control valve of the same type. You can also download the setting data
from a PC or notebook to the memory pen when you are, for example, in your office or at
the place of installation of the control valve. Then, you can download this data to the positioner
of the corresponding actuator on site. Furthermore, you can archive the setting data of the
positioner of your actuator in the memory pen. If you have to replace this actuator by a new
one, you can download the archived setting from the memory pen to the new actuator.

18
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Note that the calibration data needed for setting the hardware components of the positioner
can only be loaded and transferred using the operator interface and not by means of the
SAMSON memory pen. The memory pen can only be used to load and transfer the setting
data of the positioner. All setting data of operating mode 3 can be downloaded from the
memory pen or PC to the positioner whereas the operating modes 1 and 2 only allow the information whether the mA or V unit is to be used for the input variable and the position feedback signal to be downloaded from the memory pen or PC to the positioner. All operating
modes, however, allow you to upload all setting data from the positioner to the memory pen
or the operator interface. Regardless of the operating mode selected, the interface always
uploads the setting data of all operating modes.
In order to transfer, for example, the setting data of the positioner from the memory pen to
the positioner, first set the selector switch (2, Fig. 2) to operating mode 0 and then plug the
memory pen into the jack of the positioner to enable communication between the two
components. The associated signal lamp (9) starts to blink for about 10 seconds to indicate
that communication has been established successfully and that the setting data is being
checked.
If the positioner considers the transferred data to be incorrect, corrupt or incompatible, the
data transfer is canceled and the signal lamp (9) is not lit continuously. In this case, connect
the memory pen to the PC via the adapter, open the Setting folder of the corresponding
Operating mode folder and then select Upload from Memory Pen on the Memory Pen menu
of the TROVIS-VIEW Operator Interface to display and check the data stored in the memory
pen.
If the positioner considers the data to be correct, the data transfer is carried out. After that
the signal lamp stops blinking and remains lit, indicating that the data transfer has been
carried out successfully. The signal lamp does not go out until the memory pen has been
disconnected from the jack.
In order to activate the new setting and start the control operation, reset the selector switch
(2) to operating mode 3.

Note: Select the Setting folder of the Operating mode 3 folder to set the travel and closed
position of the control valve when using the memory pen.

EB 8331-2EN

19

SAMSON memory pen

5.1 Downloading data from SAMSON memory pen to positioner (writing)
Note: Before you download data from the SAMSON memory pen to the positioner, you
must first mount the actuator onto the control valve as described in section 2.2 and
establish the electrical connections as described in section 3 of the mounting and operating
instructions EB 8331-1 EN.
1. Set the selector switch (2) to operating mode 0 =
Fig. 2 on page 10.

(control switched off). Also refer to

2. Check if the rated travel indicated on top of the potentiometer gear (12) corresponds
with the rated travel of the control valve.
The inscription for rated travel ("Nennhub") is
15 (for 6 to 20 mm travel) on one side or
30 (for 6 to 35 mm travel) on the other side of the potentiometer gear.
If the rated travel indicated on top of the potentiometer gear and hence the mounting
position of the gear (see Fig. 2) do not correspond with the rated travel of the control valve,
pull the gear off the shaft and put it back on again with the other side facing upward,
allowing the mating gear (14) to engage properly.
Make sure that the shaft of the potentiometer (13) is not altered.
Important: Actuators with fail-safe action "actuator stem retracts or extends" are only
designed for rated travel 15 mm. Do not rearrange the gear.
3. Switch on auxiliary power.
4. Plug the SAMSON memory pen into the jack (11) of the positioner board and wait until
the signal lamp (9) stops blinking and then remains lit.
5. If you want to use the travel value and the closed position of the control valve indicated
in the Setting subfolder of the Operating mode 3 folder, initialize the travel calibration
by activating the travel calibration button (4). If, however, this is not the case,
disconnect the memory pen from the jack, set the selector switch (2) to operating mode 3
and carry out the travel calibration according to EB 8331-1 EN, pages 13 and 14.
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CAUTION
The automatic travel calibration lasts approximately twice as long as the actuators
transit time. During this, the valve moves out of its present position. Carry out the
travel calibration on the test bench or when the shut-off valves in the plant are closed.
After having activated the travel calibration button (4), both signal lamps (8 and 9) remain
lit at the same time to indicate the beginning of the travel calibration. The actuator stem
extends as far as the closed position of the valve. The mounting position of the potentiometer
gear (12) is determined automatically and signalized by the illumination of the signal lamp
(8) for 6 to 35 mm travel and the signal lamp (9) for 6 to 20 mm travel. Then, the actuator
stem retracts as far as the opened position (maximum travel). When the maximum travel
position is reached, the travel calibration is over. The actuator starts its control operation and
the actuator stem moves to the valve position determined by the reference variable.
Important: If one signal lamp starts to blink slowly after the travel calibration button has
been activated and the actuator stem has extended as far as the closed position, the
potentiometer shaft (13) has been wrongly positioned and must be readjusted manually.
But do not alter the potentiometer shaft until the closed position is actually reached. The
closed position is indicated by the associated limit switch located on the board and
activated by the tag. In order to adjust the shaft of the potentiometer (13), use a screwdriver
to turn the shaft gradually clockwise or counterclockwise until the signal lamp stops blinking
and remains lit. Turn the screwdriver counterclockwise in accordance with the symbols (7) if
the upper signal lamp (8) blinks and turn it clockwise if the lower signal lamp (9) blinks.
The travel calibration does not continue until both signal lamps are lit at the same time.
Note: If both signal lamps start to blink at the same time during the travel calibration,
disconnect the memory pen from the jack and cancel the calibration by activating the
travel calibration button. Then recheck the mounting position of the potentiometer gear
(12) and/or the travel value indicated in the Setting folder of operating mode 3.
If there is no travel movement during the calibration (due to a loose or missing potentiometer
gear, for example), both signal lamps blink alternately. In this case, cancel the travel
calibration by activating the travel calibration button (4), remedy the error and restart
the calibration by activating the travel calibration button (4) again.
Important: The travel calibration has to be carried out only once to start up the valve.
6. Disconnect the memory pen from the jack.
7. Set the selector switch (2) to operating mode 3.

EB 8331-2EN
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5.2 Uploading data from positioner to SAMSON memory pen (reading)
1. Plug the SAMSON memory pen into the jack of the positioner board and wait until the
signal lamp (9) stops blinking and is then lit continuously.
2. Disconnect the SAMSON memory pen from the jack (11).
The setting data of the positioner is stored in the memory pen and can be transferred to
further actuators or can be downloaded to the PC.
Note: You can only transfer the setting data from the positioner to the SAMSON memory
pen if you have selected one of the operating modes 1, 2 or 3!
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